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Foreword 
 

ICAR-Directorate of Coldwater Fisheries Research, 

Bhimtal, is one of the country's premier institute for undertaking 

research, development, capacity building, and extension activities 

in the Himalayan region, focusing primarily on the Coldwater 

fisheries and aquatic resources. The Directorate has carried out a 

strenuous exercise towards developing a roadmap for the country's 

coldwater fisheries and aquaculture, especially trout farming. 

Through its outreach and extension programs, the Directorate has 

contributed substantially to the development of marginal and 

weaker sections of the society in the Himalayan region. 

In today's rapidly advancing technological landscape, 

integrating geospatial tools such as remote sensing (RS) and 

geographical information systems (GIS) has become indispensable 

for sustainable resource management. The fisheries sector, particularly 

coldwater fishery resources, is no exception. These modern tools enable precise mapping, 

monitoring, and sustainable planning, ensuring the efficient utilization and conservation of aquatic 

ecosystems. Recognizing the growing need for capacity building in geospatial applications for 

fisheries, this training manual has been developed to serve as a comprehensive guide for 

researchers, academicians, students, and professionals. It provides an in-depth understanding of 

Remote Sensing, GIS, and GPS technologies and their applications in coldwater fisheries resource 

management. This manual is designed to be hands-on and practical, enabling trainees to develop 

the necessary spatial data analysis and decision-making skills. The step-by-step guidance on 

creating maps and utilizing GIS software ensures learners can confidently apply these techniques 

in real-world scenarios. 

I extend my appreciation to the authors and contributors for their efforts in compiling this 

valuable resource. I hope this manual will empower participants with the knowledge and technical 

expertise required to harness geospatial technologies for the sustainable development of coldwater 

fisheries and other natural resource management initiatives. 

 

I wish all the participants a productive and insightful learning experience. 

 

 
(Pramod Kumar Pandey) 
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Coldwater fishery Resources of India: Strategy for sustainable utilization. 

Parvaiz Ahamd Ganie*, Suresh Chandra, Raja Aadil Hussain Bhat, Ananya Khatei and 

Pramod Kumar Pandey 

ICAR-Directorate of Coldwater Fisheries Research, Bhimtal, Uttarakhand-263136. 

 

Corresponding author email: parvaiz.ganie@icar.gov.in 

Introduction 

On a global level, mountains are the world's largest repositories of biological diversity. 

Mountain regions are characterized by the presence of cold waters, many of which harbour 

fish and support largely subsistence fisheries. India has significant cold-water/hill fishery 

resources of which some are suitable for food, and few others have sport and ornamental value. 

These extend from north western to north-eastern Himalayan region and some parts of Western 

Ghats, encompassing about twelve states. The term ‘coldwater’ generally refers to the aquatic 

ecosystem, which maintains thermal and oxygen levels for well-being of trouts, mahseers, 

snow trouts and other minor species. The temperature generally falls within the tolerance 

limits of trouts and salmons belonging to family salmonidae (<20°C). A number of physical, 

chemical, geochemical and biological parameters of different water bodies e.g. water 

temperature, dissolved oxygen, velocity, turbidity, substratum, trophic status, food availability 

etc. influence the distribution and abundance of various species of coldwater fisheries. In 

Indian subcontinent, coldwater fishes are generally the natives of the Himalayan and 

subHimalayan zones in the north and watersheds draining the southern slope of Deccan 

plateau (Sunder et al., 1999). From a North American perspective, Lyon et al. (2009) have 

distinguished cold waters from warm waters on the basis of mean summer temperature and 

the maximum mean daily temperature (Table 1). In cold waters, the maximum mean daily 

temperature remains lower than or nearly equals the mean summer temperature of warm 

waters. The atmospheric temperature declines with the elevation above the mean sea level as 

well as with the latitude. In India, the situation is a bit complex as the climate is greatly 

influenced by the monsoons and the Himalayan mountain ranges. Because almost the entire 

country lies within the tropical and subtropical zone (below 38° N latitude), and is well 

protected by the high Himalayan mountain ranges against the cold winds from the north, the 

mean daily temperature during the summer merely drops to 20 °C. Therefore, the altitude is 

the main determinant of the cold water conditions in the Himalayan belt. Generally, the aquatic 

systems lying above 2500 m above sea level are considered to constitute the coldwater 

habitats. It is noteworthy that the mean temperature of water in all Kumaon lakes during the 

summers remains above the 20 °C threshold, the maximum temperature rises well above 25 

°C (Johri et al., 1989). Thus, according to the criteria of Lyons et al. (2009), these lakes do not 

qualify to be coldwater lakes. However, Sehgal (1999) and Raina and Petr (1999) included the 

aquatic habitats at elevations far lower than 1500 m also in their accounts of coldwater fish 

and fisheries. In general view, a distinction between cold and warm waters must be based on 

the temperature thresholds of fish and other important aquatic biota in the Himalayan region. 

This is an important area for research in India (Gopal, 2012). 

Table 1: Thermal classification of streams in Wisconsin (Lyons et al., 2009) 

mailto:parvaiz.ganie@icar.gov.in
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S. No. Class MeanJulyAugust Mean July Max. DailyMean 

1. Coldwater <17.0 <17.5 <20.7 

2. Cool water 17.020.5 17.521.0 20.724.6 

3. CoolTransition 17.018.7 17.519.5 20.722.6 

4. Warm Transition 18.720.5 19.521.0 22.624.6 

5. Warm water >20.5 >21.0 >24.6 

 

Coldwater fisheries occupy an important place in fisheries sector of India. The country 

is bestowed with vast and varied coldwater / hill fishery resources which are spread over the 

Himalayan and peninsular regions as upland rivers, streams, high and low altitude natural 

lakes and reservoirs. There are around 10,000 km long streams and rivers, 20,500 ha natural 

lakes, 50,000 ha of reservoirs, both natural and manmade, and 2500 ha brackish water lakes 

in the high altitude (Mahanta & Sarma, 2010).This diverse natural resource-base, wide 

climatic diversity vis-à-vis altitude are conducive to conserve and rear different fish species, 

developing domestic market for high value fish and growing interest of people aquarium pet 

keeping and eco-tourism including angling in different altitudinal regions of the country. 

The coldwater rivers and hill streams are known for their high velocity, waterfalls, 

rapids, cascades, deep pools and substratum comprising with bedrock-boulder-sand.These 

water resources harbour 258 fish species belonging to 21 families and 76 genera in the country 

of which 203 are recorded from the Himalayas while, 91 from the Deccan Plateau (Sehgal, 

1999).The North Eastern states have also rich Ichthyo faunal diversity.Of which majority are 

food fishes while others have potential ornamental and sports value. In the Indian Himalayas, 

the cultivation of fish contributes little to the overall freshwater fish production.Virtually, 

every facility created for fish cultivation in the Indian Himalaya produces fish for stocking 

into the streams and lakes primarily to meet the requirements of sport fishing. 

The present exploitation of fishery resources in upland regions comes mainly in the 

form of capture fisheries serving as subsistence fishery, though fish production through culture 

practices is also gaining popularity. At present, the contribution towards national fish 

production from the upland sector is very meagre. This is attributable to several constraints 

such as low productivity of upland waters, comparatively slow growth rate in majority of fish 

species, low fecundity and and selective fishing gears in operation. The ICAR-Directorate of 

Coldwater Fisheries Research (DCFR) being a national organization is catering the research 

and development need of the upland waters has achieved manifold success in the management 

of fish genetic diversity and establishment of aquaculture in the hill regions of India. 

Himalayan Aquatic Resources and Environment 

The Indian Himalayan region spreading between 21o57' to37o5' N latitudes and 72o40' 

to 97o25' E longitudes with 250-300 km across stretches over 2,500 km from Jammu and 

Kashmir in the west to Arunachal Pradesh in the east. These mountainous region cover 

partially or fully twelve states of India, viz., Jammu & Kashmir, Himachal Pradesh, 

Uttarakhand, Sikkim,Arunachal Pradesh, Nagaland, Manipur, Mizoram, Tripura, Meghalaya 



ICAR-DCFR 01-2025 
 

3 | C o l d w a t e r  r e s o u r c e  m a p p i n g  u s i n g  g e o s p a t i a l  t o o l s ,  1 9 - 2 1  
F e b ,  2 0 2 5  
 

and hills of Assam and West Bengal. The region has atotal geographical area of about 5,33,604 

km2 being inhabited by 3,96,28,311 people, representing about 16.2% of total area and 3.86% 

of total population of India, respectively. 

The region is vast, uneven and versatile inhabiting rich floral and faunal diversity and 

is divided into eastern Himalaya, central Himalaya and western Himalaya, each with different 

physiography and faunal diversity. Topographically, Himalayas from South to North is divided 

into four parallel & longitudinal mountain belts (Table 2). 

Based on the altitudinal gradient, the agro-climatic zones in the Indian Himalayan 

region are broadly classified as warm sub-tropical (<800m) to arctic zone (>3,600m). 

The Indian Himalayan region has enormous fresh water resources in the form of 

streams, rivers, lakes and glaciers. It is drained by 19 major rivers of which the Indus, the 

Ganges, and the Brahmaputra are exemplary ones. The Indus and the Brahmaputra are the 

longest, each having a mountain catchment of about 160,000 km2. Five rivers (Jhelum, 

Chenab, Sutlej, Ravi, Beas) belong to the Indus system, of which the Beas and the Sutlej have 

a total catchment area of 80,000 km2; Nine (Ganga, Yamuna, Ram Ganga, Kali-Sharda, 

Karnali, Rapti,Gandak, Bhagmati and Kosi) belong to the Ganga system, draining nearly 

150,000 km2; and three (Tista, Raidak and Manas) belong to the Brahmaputra system, draining 

another 110,000 km2. Most of these rivers flow in deep valleys until they exit the mountains 

(Sehgal, 1999). 

Table 2: Major divisions of Himalayan region (Sehgal, 1999) 

S.No. Division  Features  

1 The Greater Himalayas 

(Himadri)  

Longest and continuous, mostly north part of Nepal 

and parts of Sikkim. Average altitude of about 6100 

m (20,000 ft) asl.  

2. Lesser Himalayas  

(Himanchal)  

In the south and north of Siwalik. Average altitude 

ranging from 3700m (12,000) - 4500m (15,000 ft) 

asl.  

3. Siwalik  

(Outer Himalaya)  

Siwalik is the lowest and narrowest section of 

Himalaya. Average altitude about 900m (3000ft) to 

1200m (4000 feet) asl.  

4. Trans-Himalayas  Stretches across Himalaya from West to East for 

about 1,000 km. Average altitude varies from 4500 to 

6600 m asl.  

 

There are numbers of lakes, of different sizes, situated in the mid and high altitudes of 

Himalayan regions with diverse origins, such as retreat of glaciers, landslides. In the Great 

Himalayan and Trans-Himalayan region lakes are present at high altitude, with the highest 

lake situated at 5297 m asl. Jana (1998) listed 13 lakes situated from 3400 m to 5297 m, some 

of them being brackish or saline. Freshwater lakes in Kashmir Valley are believed to have 

originated as oxbow lakes of the Jhelum River (Raina, 1999). Large lakes having 15,300 ha 
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of surface area are located at middle altitude (1537 to 1587 m) in the State of Jammu and 

Kashmir while Kumaon lakes situated (1237 to 1930 m asl) in the state of Uttarakhand are 

much smaller, with the largest only 72 ha. In Himachal Pradesh Coldwater lakes are situated 

between 1306 and 4815 m asl. The state wise water resources including rivers and canals total 

replenishable ground water, major rivers, major wetlands and fish diversity are given in Table 

3. 

Table 3: State wise water resources in the region 

State Length of 

rivers/can

als  

(thousand 

km) 

Water 

bodies 

(lakh 

hectare

) 

Total 

replenis

hable 

ground 

water 

Major rivers  Major 

wetlands 

Recorded 

Fish 

diversity 

Jammu & 

Kashmir 

27.78 0.30 4425.84 Indus  

Zanskar 

Shyok 

Jhelum 

Lidder  

Bringhi 

Chenab  

Tawi etc 

Dal  

Wular Mansbal 

Anchar 

Gangbal 

Vishansar 

Pangong 

Tso,Marsar 

Gadsar etc 

26 

Himachal 

Pradesh 

3.00 0.43 365.81 Spiti  

Sutlej  

Beas  

Ravi etc 

Renuka 

Lam Dal 

Kareri 

Khajiar 

Chandertal 

82 

Uttarakhand 2.69 0.20 - Alaknanda 

Dhauliganga 

Pindar  

Mandakini 

Bhagirathi 

Ramganga-W 

Kosi  

Bhilangna 

Nainital  

Bhimtal   

Sattal 

Naukuchiatal 

Garudtal 

Khurpatal 

Shyamlatal 

67 

Sikkim 0.90 0.03 - Tista  

Lachung Chhu  

Rongni Chhu  

TolungChhu  

Upper Rangit  

Memencho 

Tsomgo 

Elephant Lake 

Khora Chhobuk 

 lake 

23 

Meghalaya 5.60 0.10 539.66 Digaru 

Kopili  

Myntdu  

 Piyain 

Someshwari  

Thadlaskein  

Umang 

Umiam 

Wards lake 

165 
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Tripura 1.20 0.17 663.41 Burima   

Gomati  

Manu 

Dhalai  

Khowai  

Haora  

Dumboor 

Amarsagar 

Rudrasagar 

Kamalasagar 

Khowra 

Kalyansagar 

Jagannath dighi 

134 

Mizoram 1.40 0.02 - Tlawng  

Tlau 

Chhimtuipui 

Tuichang 

Tuivawl 

Teirei 

Tamdil 

Palak  

Rungdil  

Rengdil  

 

48 

Manipur 3.36 0.46 3154.00 Barak 

 Iril 

Nambul  

Tiau 

Ikop pat  

Loktak  

Pumlen pat 

121 

Nagaland 1.60 0.67 724.00 Doyang 

Dhansiri  

Dikhu  

Tizu 

Milak 

Langlong 

Likimro 

Shilloi  

Dzudu 

Tsumang 

Totsu  

Wozhu l  

Lake aizuto 

68 

Arunachal 

Pradesh 

2.00 0.04 1438.50 
Dhibang  

Dirang  

Subansari  

Kameng  

Tawang Chu  

Nagula  

Seri  

Pangateng tso,  

Tensing 

Madhuri Lake 

Ganga Lake 

167 

[Source: Hand book on Fisheries Statistics 1996, Department of Agriculture and 

Cooperationand Ground Water Statistics 1996, Central Ground Water Board] mcm: Million 

cubic Metres Water bodies include reservoirs, lakes, ponds, tanks, beels and oxbow, etc. 

Data for the hill districts of Assam and West Bengal are not available separately;  Shanawaz 

ali-2010; Singh, A.K., 2015; Kumar et al-2017] 

Fish biodiversity 

The water bodies of the Himalayan region inhabit diverse kind of fish fauna. Out of 

total fish fauna available in India 17% fishes were documented from the mountain ecosystem 

establishing the status of the area as a centre of origin and evolution of biotic forms (Ghosh, 

1997).  

The coldwater fisheries harbour 258 species belonging to 21 families and 76 genera. Out of 

these, the maximum of 255 species are recorded from North-East Himalaya, 203 from the west 

and central Himalaya and 91 from the Deccan plateau (Sehgal, 1999). Singh et al, 2014, 

reported that the vast mountain fishery resources of India inhabits around 258 fish species 
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distributed in the Himalayan and peninsular region of the country of which indigenous 

mahseer, snow trout, exotic trout and common carp are commercially important. About 36 

species of freshwater fishes (out of 1,300) are endemic to the Himalayan region (Ghosh, 1997). 

For the whole Himalayas, 218 species are listed (Menon, 1962). The distribution of fish 

species in the Himalayan streams depends on the flow rate, nature of substratum, water 

temperature and the availability of food (Table 4). The species distribution and composition 

in the upper reaches and lower reaches is different owing to the differential flow rates and 

substratum variability. The eastern Himalaya, drained by the Brahmaputra has agreater 

diversity of Coldwater fish than the western Himalayan drainage  

Table 4: Important Coldwater Fish Species of Indian Himalayas 

Important Coldwater Fish Species 

Snow trout: 

Schizothorax richardsonni 

Schizothoraichthys 

curvifrons 

S. esocinus 

S. niger 

S. plagiostomus 

S. progastus 

Lepidopygopsis typus 

Diptychus maculatus 

Mahseer: 

Tor putitora 

T. tor 

T. khudree 

Neolissochilus 

hexagonolepis 

Neolissochielus 

wynaadensis, 

Naziritor cheylinoides 

Exotic trouts: 

Onchorhynchus mykiss 

Salmo trutta fario 

Exotic carps: 

Cyprinuscarpio var. 

specularis 

C. carpio var. communis 

C. Carpio Var. nudus 

Ctenopharyngodon idella 

Hyphthalmichthys molitrix 

Carrasius carrasius 

Minor carps: 

Labeo dyocheilus 

Labeo dero 

Chagunius chagunio 

Crossocheilus latius latius 

Gara gotyla, 

G. hughi, 

G. lamta,  

Puntius conchonius, 

 P. ophiocephalus,  

Semiplotus semiplotus 

Barils/Minnows/Catfishes/ 

Loaches: 

Barilius bendelisis 

B. bakeri 

B. vagra 

B. barila 

Raimas bola 

Danio devario 

Botia birdi 

B almorhae 

Glyptothorax pectinopterus 

G. brevipinnis  

G. stoliczkae 

Pseudechenesis multifasciatus 

Nemacheilus rupecols 

N. multifasciatus, 

 

The commercially important Indian coldwater species are Tor tor, T. putiora, T. mosal, 

T.progeneius, T. khudree, T. mussullah, T. malabaricus, Naziritor chelynoides, Neolissochielus 

wynaadensis, N. hexagonolepis, Schizothoraichthys progastus, S. esocinus, Schizothorax 

richardsonii, S. plagiostomus, S. curvifrons, S.micropogon, S. kumaonensis, Barilius 

bendelisis,B. vagra, B. shacra, B. (Raiamas) bola, Bangana dero, Labeo dyocheilus, 

Crossocheilus periyarensis, Semiplotus semiplotus, Osteobram abelangeri, Garra lamta, 

Garra gotyla gotyla, Glyptothorax pectinopterus, G. brevipinnis, G. stoliczkae, Chagunius 

chagunio, Labeo dero, L. dyocheilus and Lepidopygopsis typus (Sehgal, 1999; Sunder et al., 

1999; Jena and Gopalakrishnan, 2012;   Sehgal, 2012). 
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Mahseer is a group of game fish that belongs primarily to the genus Tor, but also 

includes some species of the genus Neolissochilus (e.g. Chocolate mahseer Neolissochilus 

hexagonolepis). Schizothoracines (family Cyprinidae and sub-family Schizothoracinae) on 

the other hand, contribute to an economically significant group of hill stream fishes all along 

the Himalayan belt especially from Kashmir Himalaya. Out of about 258 cold water fish 

species (both indigenous and exotic) reported from Indian uplands, 17 members of snow-

trout’s (locally known as “Asela, Sela or Rasella” in Uttarakhand, “Gulgali” in Himachal and 

“Koushar gad” in Kashmir Himalayas) have been recognized by many authors (Talwar and 

Jhingran, 1991; Tilak, 1987 and Sundar et al., 1999). Of these, 10 species belong to genus 

Schizothorachthys species being (niger, esocinus, curvifrons, longipinnias, micropogon, 

planifrons, hugelli, labiatus, nasus, progastus), two to genus Schizothorax (species being 

richardsonii and  kumaonensis) and one each to Diptychus (maculates), Gymnocypris 

(biswasi), Lepidopygopsis (typus), Ptychobarbus (conirostris), Schizopygopsis (stoliczkae). 

Only Lapidopygopisis typus is restricted to Periyarlake (Western ghats), Kerala. All other 

species are available from Jammu and Kashmir region. Schizothorax richardsonii is most 

common and widely distributed species in Himalayan belt (Sehgal, 1999). 

Mountain fisheries and hill aquaculture 

The present exploitation of fishery resources in upland regions comes mainly from 

capture fisheries, though fish production through culture practices is gaining momentum. Fish 

production in hill region is confined to inland waters such as river streams, lakes and 

reservoirs. The production from such facilities is not up to the mark possibly due to several 

constraints such as low productivity of upland waters, comparatively slow growth rate in 

almost all fish species and low fecundity in fishes. 

Culture of coldwater fish in the Indian Himalayas has largely focussed on the 

production of stocking material for rivers and streams, and some lakes. Until recently, carps, 

mahseer,  snow trout, and rainbow trout dominated the fish cultured for fish seed production, 

and to a much lesser extent for table fish production. Today, the available technologies allow 

the culture of a number of exotic and indigenous coldwater fish species in the Indian 

Himalayas. The most commonly cultured ones include exotic species  such as Rainbow trout, 

Brown trout, Common carp , and the indigenous fishes such as Mahseer (Golden and 

Choclate), and Schizothoracines (Schizothoraichthys esocinus, S. progastus, Schizothorax 

richardsonii, S. niger and S. curvifrons). Among these Tor putitora, S. progastus and S. 

richardsonii are preferred for fishery because of their wide range of distribution in the 

Himalayas. 

 Catches of snow trout have been reported to the tune of 67-74% from north-western 

Himalayas; 59-67% from Uttaranchal Himalayan streams/rivers, however, by and large their 

overall size frequency have gone down by 10-20% over the years (Sunder, 2005). Besides 

indiscriminate killing, destructive fishing methods and ecological degradation the inherent 

biological factors of low fecundity and long hatching period have further added its decline in 

the natural streams. Various in-situ and ex-situ conservation efforts have been identified based 

on the resource assessment of Schizothoracine. Although some success have been achieved in 
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artificial propagation of snow trout species such as S. richardsonii (Vass, 2012) and S. niger 

(Najar et al., 2014), in the recent past, the culture of schizothoracines is still in its experimental 

stage. There is still work to be done on schizothoracine seed production to achieve a fully 

viable fingerling stage ready for release into rivers and lakes 

Mahseers (Tor spp.) of the family Cyprinidae are regarded as one of the best sport fish 

and also a sought-after food fish. In the Indian Himalayas mahseer stocks have sharply 

declined, due to man-caused deterioration of the environment and overfishing. Owing to its 

endangered status, mahseer conservation has become utmost priority for enhancing its natural 

population in the streams and rivers of Himalayas. Earlier seed of mahseer was collected from 

natural sources but recently seed has been produced through artificial propagation. However, 

with the devoted efforts of ICAR-DCFR, the artificial propagation of the fish is possible now. 

The protocol for breeding and propagation has been standardised wherein the brood stock is 

collected from natural grounds in rivers, lakes etc are stripped of their eggs and milt and 

fertilized eggs are incubated in specially developed flow through hatchery. This technique 

enables the production of pure and healthy seed in captive condition.  This seed can be used 

for augmentation of natural stock through ranching and aquaculture of this species.   

In the upland waters, Chinese carps are commonly cultured in the mid-Himalayan 

region as the candidate species for polyculture. Culture of rainbow trout (Oncorhynchus 

mykiss and brown trout (Salmo trutta fario) in the hill states have been considered as the 

promising species for mountain fisheries development in India. Today, farming of Rainbow 

trout is being carried out on several fish farms in Jammu and Kashmir, Himachal Pradesh, 

Uttrakhand, Arunachal Pradesh and Sikkim. The siting of these aquaculture facilities was 

based on the availability of water in required quantity and quality, i.e. from rheocrene springs 

and snow-melt/glacier-fed streams. 

Most farms receive water supply from snow-melt/glacier-fed streams. A total of 30 

trout hatcheries with an estimated eyed ova production capacity of 13 million are present in 

the country which have been mostly established by the various state governments and also 

with the assistance of central government schemes. The state of Jammu & Kashmir and 

Himachal Pradesh are forerunner in promoting rainbow trout farming in private sector. The 

highest trout producer state in India is Jammu & Kashmir with a table size trout production of 

260 MT and 8 million trout ova production. The Himachal Pradesh is second highest producer 

(168 MT) in the country.  

Challenges 

The climate change is a worldwide phenomenon. It refers to any significant change in 

climate through temperature and rainfall pattern etc. for an extended period of decades or 

longer, as a result of natural processes and anthropogenic activities. As global warming 

continues to increase the atmospheric temperature, it will lead to a continuous shift of zero 

temperature line (snow line) towards higher altitudes. Climate change is affecting Coldwater 

resources and their fisheries through its impact on flow regimes of streams, phenological 

changes, food chain, micro habitats and overall productivity. The changed eco-climatic 

conditions would adversely impact the pristine feeding and breeding grounds of the native 
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coldwater fish species their population, maturity condition and spawning and related vital life 

cycle phenomenon.  

Management strategies for sustainable utilization 

There is a need of introduction of large scale farming to bring the mountain fishery 

and aquaculture in India on international scenario. Coldwater fisheries for livelihood and 

industry are the two modern concepts which aim to provide sufficient fish locally at cheaper 

price as nutritional security and to export the fish and fishery products to earn the foreign 

currency. .    

Following points need to be taken care of for managing the coldwater resources in a 

sustainable manner. 

1. To develop the coldwater sector in an integrated manner, mapping of the fishery 

resources in mountain/ hill region needs to be taken up on priority basis  

2. Production enhancement, either species or stock, in lentic and lotic systems by means 

of sustainable intensive culture practices needs to be taken up. 

3. Horizontal and vertical expansion of fish culture activities through identification of, 

suitable land/water bodies using modern tools of technology and their micro climatic 

conditions should be brought under any of the three pronged fish farming practices. 

4. Regular  monitoring  of  reproductive  biology of  economically  important  fish  spec

ies  so as  to  suggest  remedial  measures  for  depleting  population.  

5. Extensive  conservation  and  bio  monitoring  of  all  coldwater  resources  in  time  

and  space  to  assess  threat  perspectives  in  relation  to  biodiversity. 

6. Conservation  and  rational  exploitation  of  resources,  which  are  the  backbone  of

  fish  

and  fisheries  in  the  region  particularly  at  the  high  altitude  areas. 

7. Development of sport/recreational fishery for tourism and employment generation. 

8. Ownership of resources needs to be decided 

9. A balanced strategy for lakes, for tourism and fishery development needs to be 

formulated. 

10. Location specific legal framework needs to be formulated and implemented 

religiously. 

11. Fish breeding and nursery sites need special protection by declaring them “Restricted 

or No-fishing zones” 

12. Education, training and extension support to the hill communities for resource 

conservation and sustainable utilization. 

13.  Promoting awareness on sustainable use of mountain natural resources (aqua-

gardening) and conservation of biological diversity for maintaining mountain 

ecosystems. 

 

************************** 
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Introduction 

Remote sensing is a technology for acquiring information about the earth's surface 

without actually being in contact with it. This is done by sensing and recording reflection or 

emitted energy & processing, analyzing, and applying that information. In this technology, 

special cameras collect images from the objectives and then sense the images accordingly to 

provide information and sense things about the earth. 

It is the science & art of obtaining information about an object, area, or phenomenon 

(earth's surface) through the analysis of data acquired by a device that is not in direct contact 

with the object, area, or phenomena under the investigation. It helps in essential global matters 

such as climate change, global warming, etc. 

In other words, remote sensing can be defined as the science and art of obtaining 

information about an object, area, or phenomenon through satellite. The science & art of 

acquiring information about an object without entering into contact with it, by sensing or 

recording the reflected or emitted energy and processing, analyzing, and applying that 

information in remote sensing. 

It is used in several fields like geography, geology, ecology, glaciology, hydrology, and 

oceanography. Special cameras present collect remotely sensed pictures, which helps the 

researchers “sense” the things about the Earth and other planets. Remote sensing when 

combined with GIS technology helps in important database operations like queries with maps, 

and statistical analysis. 

This technology started with the invention of the camera. Initial photographs were just 

simple photographs, but the intention of taking the Earth’s images for its graphic mapping 

arose during the year 1840 and due to this concept scientists started to fix cameras on balloons 

just to take a wide range of images. During the era of WWI, cameras were placed on airplanes 

just to get an aerial view image of landslides. Only during the space age era did satellite remote 

sensing develop. It was used for the objective of imaging the Earth’s surfaces as well as 

sensing other spacecraft, and other planets. 

Components 

There are three essential components of remote sensing system –  

• Remote sensing platforms  

• Remote sensing sensors 

• Remote sensing orbits  
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Remote Sensing Platforms 

A platform is the vehicle or carrier for remote sensors. A platform is needed to hold the 

instrument and there are three types of platforms in Remote Sensing –  

• Ground based platform 

• Airborne platforms 

• Space borne platform 

 
Fig: Different types of platforms used in remote sensing 

 

1. Ground Based Platform 

Ground based platform used to record detail information about the surface very closely. These 

are the ground level platforms such as cranes and towers. Some example of ground-based 

platform are:  

• Ground vehicle   

• Tower  

• Air balloon  

• Kite 

The height of ground-based platform is up to 50 m or in the other words we can say that 

the ground-based platforms are found above 50 m from the Earth surface.  

2. Airborne Platforms 

They are used to collect very detailed images and facilities the collection of data over any 

portion of Earth’s surface at any time but it is very expensive platform as compared to ground-

based platforms. The height of airborne platform is above 50 km from earth surface.  These 

are the aerial platforms such as : 
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• Aeroplane  

• High altitude aircraft  

• Helicopters 

3. Space Borne Platform 

Some examples of space borne platform are as follows: 

• Rocket satellite space shuttle whose height is 250 to 300 km above from the Earth 

surface  

• Space station which whose height is 300 to 400 km  

• Low level satellite which is also known as polar satellite whose height is 700 to 

1500 km  

• High level satellites which are also known as geostationary satellites whose height 

is 36000 km above the Earth's surface 

Remote Sensing Sensors 

Remote sensors collect data by collecting the energy which is reflected from the Earth, it is 

based on sensor technology to detect, in order to observe the target the sensors are needed and 

classify the object. The classification of sensors are as follows: 

• Passive Sensors: They detect natural energy(radiation) that is emitted or reflected by 

the object or scene being observed. Reflected sunlight is the most common source of 

radiation measured by passive sensors. The passive sensors detect the energy which is 

reflected from the environment. 

• Active sensors: They transmit their own signal and measure the energy that is 

reflected and transmitted back or scatter back from the target. For example, radar sonar. 

So in general , they provide their own source of energy to illuminate the object which 

they observe. 

Working 

The various steps involved in remote sensing is given as follows:  

1. Energy source - The first requirement for remote sensing is to have an energy source 

which illuminate or provide electromagnetic energy to the target of interest.  

2. Radiation and atmosphere - As the energy travels from its source to the target, it 

will come in contact with or interact with the atmosphere it passes through; this 

interaction may take place a second as the energy travels from the target to the 

sensor.  

3. Interaction with the target - Once the energy makes it way to the target through the 

atmosphere, it interacts with the target depending upon the properties of both the 

target & radiation  
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4. Recording of energy by the sensors - After the energy has been scattered by, 

emitted from the target, we require a sensor (remote-not in contact with the target) to 

collect and record the electromagnetic radiation.  

5. Transmission, reception and processing -The energy required by the sensors has to 

be transmitted, often in electronic form, to receive and processing section where the 

data are produced into an image (hard copy & digital).  

6. Interpretation and analysis -The proceed image is interpreted in two types visually 

and digitally. To extract information about the target which was illuminated.  

7. Application - The final element of remote sensing process is achieved when we 

apply the information - we have been able to extract from the imagery about the 

target in order to better understand and reveal some new information. 

8. Electromagnetic radiation --- electromagnetic radiation refers to the waves of the 

electromagnetic field, propagating through space, carrying electromagnetic radiant 

energy. It includes radio waves, microwaves, infrared, light, ultraviolet, X-rays, and 

gamma rays. 

 
Fig: Elements involved in remote sensing 

 

Remote Sensing Orbits 

In remote sensing, orbits play one of the major components of remote sensing. The 

path followed by a satellite is referred to as its orbit. Orbit selection can vary in terms of 

altitude (their height above the Earth's surface) and their orientation and rotation relative to 

the Earth. Overall, low earth orbit is the best orbit for the purpose of remote sensing which is 

commonly used for communication and remote sensing. 

Types of remote sensing orbits are as follows: 

• Geostationary orbits 
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• Polar Orbit 

• Sun -Synchronous 

1. Geostationary Orbit 

Satellites at very high altitudes, which view the same portion of the Earth's surface at 

all times have geostationary orbits. These geostationary satellites, at altitudes of 

approximately 36,000 kilometers, revolve at speeds which match the rotation of the Earth so 

they seem stationary, relative to the Earth's surface. This allows the satellites to observe and 

collect information continuously over specific areas. Weather and communications satellites 

commonly have these types of orbits 

 
Fig: Geostationary Orbit 

 

2. Polar Orbit 

A polar orbit travels north-south over the poles and takes approximately an hour and a 

half for a full rotation. As a result, a satellite can observe the entire Earth’s surface (off-nadir) 

in the time span of 24 hours. Almost all the satellites that are in a polar orbit are at lower 

altitudes. Plus, they are often used for applications such as monitoring crops, forests and even 

global security.  
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Fig: Polar orbit 

 

3. Sun-Synchronous Orbit 

These orbits allow a satellite to pass over a section of the Earth. Since there are 365 

days in a year and 360 degrees in a circle, it means that the satellite has to shift its orbit by 

approximately one degree per day. These satellites orbit at an altitude between 700 to 800 km. 

 
Fig. Sun Synchronous Orbit 

 

Types of Remote Sensing 

There are two type of remote sensing sensors which is based on the sensors are as follows: 

• Passive sensors 

• Active sensors 

Passive Sensors 
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Passive sensors detect natural energy(radiation) that is emitted or reflected by the 

object or scene being observed. Reflected sunlight is the most common source of radiation 

measured by passive sensors. Sensing done via active sensors is called active sensing. For 

excitation, they often need extra electrical power. Only when the energy that naturally occurs 

is available can passive sensors be utilized to detect it, during the day can passive sensors 

gather data, electromagnetic energy is measured by the passive sensor. 

The passive sensor is defenseless against an invading force. Sensors that are passive 

wait patiently for data requests. As a result of the stimulation, the passive sensor's transducer 

causes a change in a passive electrical quantity like capacitance, resistance, or inductance. 

The passive sensor measures utilizing EM radiation that is naturally emitted within its 

field of view. Satellites used for remote sensing, such as SPOT-1 and LANDSAT-1, are 

examples of passive sensors. 

Active Sensors 

Active sensors transmit their own signal and measure the energy that is reflected and 

transmitted back or scatter back from the target. For example, radar sonar. Sensing done via 

passive sensors is called passive sensing. A transducer that is an active sensor directly 

produces electric current or voltage in response to external stimulus. The active sensor 

produces its own electromagnetic (EM) energy, transmits it toward the earth, and then collects 

energy reflected back from the planet. Electromagnetic (EM) radiation that has been received 

is used for measurement. 

They self-destructs during hijack attempts and can take measurements at any time. 

Electromagnetic energy is measured and transmitted by active sensors. Regardless of whether 

the on-duty employees want the data or not, an active sensor actively communicates 

measurement to ground stations. It provides their own energy source for illumination. 

Example of active sensor like communication satellite, earth observation satellite, LISS -1, 

etc. 
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Fig: Types of remote sensing 

 

Sensor Parameters  

Various earth surface objects are intended to be identified and mapped using the data 

gathered by the remote sensors. As a result, we can state that the classification and mapping 

accuracy requirements are used to evaluate the sensor's performance. It is reasonable to 

anticipate that this will depend on the instrument's capacity to identify minute variations in 

the earth's surface's emittance and reflectance throughout a range of spectral bands for as few 

and as frequent objects as feasible. Resolution describes the numerous parameters that define 

these various types of sensor systems. The spatial, spectral, radiometric, and temporal 

resolution of the data from remote sensing determines its quality.  

Spatial Resolution 

 The size of the ground area that a sensor "sees" at any given moment, or more 

precisely, each time a signal is collected. It is the smallest separation between two objects that 

a sensor can clearly register ability to recognize nearby little objects in a picture. Higher the 

spatial resolution, the smaller the ground resolution cell – the higher the resolving power of 

the system. By definition, spatial resolution is the mallest angular or linear separation between 

two objects that can be resolved by sensor which is determined by Instantaneous field of view 

(IFOV). The resolutions of today's satellite systems vary from a few centimeters (for example 

military usage) to kilometers. 
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Fig: Spatial Resolution 

 

Spectral Resolution  

The capacity to break down spectral features and bands into their individual 

components is known as spectral resolution. The level of spectral resolution needed by the 

analyst or researcher will depend on the application in question. It is the accuracy with which 

slight variations in the wavelength can be recorded. The finer the spectral resolution, the 

narrower the wavelength range for a particular channel or band. Different features in an image 

can be identified by comparing their wavelength responses. Broad classes such as water body 

can be identified using broad wavelength (visible and IR range), whereas more specific classes 

would require finer wavelength range to identify them such as type of rock. Thus, spectral 

resolution is the ability of the sensor to separate fine wavelength intervals. While hyperspectral 

imaging has hundreds or thousands of (narrower) bands (i.e., better spectral resolution), 

multispectral imagery often refers to 3 to 10 bands.  

A single broad band known as panchromatic captures a diverse range of wavelengths.  

• Multispectral Sensors – MODIS – moderate spectral resolution  

• Hyperspectral Sensors – OMI, AIRS – High spectral resolution 
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Fig: Spectral Resolution of Different Objects (Indian Institute of Science) 

 

Radiometric Resolution 

 It is the ability of the sensor to detect the slight variation in the EMR received. Since 

total EMR received is directly proportional to spatial resolution, there is an inverse 

relationship between spatial and radiometric resolution – low spatial resolution (large ground 

area) means more total energy received, so slight variations in EMR can be detected, this 

results in a high signal to noise ratio – conversely, if spatial resolution is high (small ground 

area) less total energy is received, slight variations are more difficult to detect, so lower signal 

to noise ratio, poorer radiometric resolution. Radiometric resolution is normally indicated by 

the number of quantization levels used to measure reflectance also called DN values for digital 

numbers. It is determined by bit format of data. It specifies how well the differences in 

brightness in an image can be perceived; this is measured through the number of the grey value 

levels. The more sensitive the sensor - the higher the radiometric resolution. If radiometric 

precision is high, an image will be sharp. 

 
Fig: Difference in Image Having Different Bits of Radiometric Resolution 

 

Temporal Resolution  

The frequency with which a remote sensing platform can cover a region is referred to 

as temporal resolution. While regular orbiting satellites can only offer data once they pass over 
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a region, geo-stationary satellites can provide continuous sensing. In order to supply data for 

applications requiring more frequent sensing, remote sensing data from cameras placed on 

aircraft is frequently used. The data from a planned remotely sensed data system may be 

tampered with by cloud cover. The highest frequent temporal resolution can be obtained via 

remote sensors placed in fields or attached to agricultural machinery. It is determined by 

orbital characteristics and swath width (the larger the swath, the higher the temporal 

resolution)  

Global coverage of various satellites is.  

• MODIS – 1-2 days  

• OMI – 1 day  

• MISR – 6-8 days  

• VIIRS – 1 day  

• Geostationary – 30 sec – 1 hr.  

It is very difficult to obtain all resolution at higher levels at the same time. 

Advantages 

• Allows coverage of very large areas which enables regional surveys on a variety of 

themes and identification of extremely large features. 

• Allows Repetitive coverage which comes in handy when collecting data on dynamic 

themes such as water, agricultural fields and so on.  

• Allows for easy collection of data over a variety of scales and resolutions.  

• A single image captured through remote sensing can be analyzed and interpreted for 

use in various applications and purposes. There is no limitation on the extent of 

information that can be gathered from a single remotely sensed image.  

• Remotely sensed data can easily be processed and analyzed fast using a computer and 

the data utilized for various purposes. 

• Remote sensing is Unobstructed especially if the sensor is passively recording the 

electromagnetic energy reflected from or emitted by the phenomena of interest. This 

means that passive remote sensing does not disturb the object or the area of interest.  

• Data collected through remote sensing is analyzed at the laboratory which minimizes 

the work that needs to be done on the field.  

• Remote sensing allows for map revision at a small to medium scale which makes it a 

bit cheaper and faster.  

• It is easier to locate floods or forest fire that has spread over a large region which makes 

it easier to plan a rescue mission easily and fast.  

• Remote sensing is a relatively cheap and constructive method reconstructing a base 

map in the absence of detailed land survey methods. 
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Disadvantages 

• Remote sensing is a fairly expensive method of analysis especially when measuring or 

analyzing smaller areas.  

• Remote sensing requires a special kind of training to analyze the images. It is therefore 

expensive in the long run to use remote sensing technology since extra training must 

be accorded to the users of the technology.  

• It is expensive to analyze repetitive photographs if there is need to analyze different 

aspects of the photography features.  

• It is humans who select what sensor needs to be used to collect the data, specify the 

resolution of the data and calibration of the sensor, select the platform that will carry 

the sensor and determine when the data will be collected. Because of this, it is easier 

to introduce human error in this kind of analysis. 

• Powerful active remote sensing systems such as radars that emit their own 

electromagnetic radiation can be intrusive and affect the phenomenon being 

investigated.  

• The instruments used in remote sensing may sometimes be un-calibrated which may 

lead to un-calibrated remote sensing data.  

• The image being analyzed may sometimes be interfered by other phenomena that are 

not being measured and this should also be accounted for during analysis.  

• Remote sensing technology is sometimes oversold to the point where it feels like it is 

a panacea that will provide all the solution and information for conducting physical, 

biological or scientific research.  

• The information provided by remote sensing data may not be complete and may be 

temporary.  

• Sometimes large-scale engineering maps cannot be prepared from satellite data which 

makes remote sensing data collection incomplete. 

Application 

• In Agriculture:  Crop type classification, Crop condition assessment, Crop yield 

estimation, Mapping of soil characteristics, Mapping of soil management practices and 

so on. 

• Forestry:  Forest cover, Type of forest, Vegetation density, Deforestation , Forest 

fires , Biomass estimation. 

• Geology:  Bedrock mapping, Lithological mapping, Structural mapping, Mineral 

exploration, Hydrocarbon exploration, Environmental geology,etc. 

• Hydrology:  Wetlands mapping and monitoring, Soil moisture estimation, Measuring 

snow thickness, etc. 
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• Sea Ice:  Ice concentration, Iceberg detection and tracking and so on. 

• Fisheries: Site suitability analysis, Water quality mapping, Habitat suitability 

assessment 

 

 

************************** 
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Introduction  

Geographical Information System (GIS) is a technology that provides the means to 

collect and use geographic data to assist in the development of Agriculture. A digital map is 

generally of much greater value than the same map printed on a paper as the digital version 

can be combined with other sources of data for analyzing information with a graphical 

presentation. The GIS software makes it possible to synthesize large amounts of different data, 

combining different layers of information to manage and retrieve the data in a more useful 

manner. GIS provides a powerful means for agricultural scientists to better service to the 

farmers and farming community in answering their query and helping in a better decision 

making to implement planning activities for the development of agriculture.  

Overview of GIS  

A Geographical Information System (GIS) is a system for capturing, storing, analyzing 

and managing data and associated attributes, which are spatially referenced to the Earth. The 

geographical information system is also called as a geographic information system or 

geospatial information system. It is an information system capable of integrating, storing, 

editing, analyzing, sharing, and displaying geographically referenced information. In a more 

generic sense, GIS is a software tool that allows users to create interactive queries, analyze 

the spatial information, edit data, maps, and present the results of all these operations. GIS 

technology is becoming essential tool to combine various maps and remote sensing 

information to generate various models, which are used in real time environment. 

Geographical information system is the science utilizing the geographic concepts, applications 

and systems.  

Geographical Information System can be used for scientific investigations, resource 

management, asset management, environmental impact assessment, urban planning, 

cartography, criminology, history, sales, marketing, and logistics. For example, agricultural 

planners might use geographical data to decide on the best locations for a location specific 

crop planning, by combining data on soils, topography, and rainfall to determine the size and 

location of biologically suitable areas. The final output could include overlays with land 

ownership, transport, infrastructure, labour availability, and distance to market centers.  

History of GIS development  

The idea of portraying different layers of data on a series of base maps, and relating 

things geographically, has been around much older than computers invention. Thousands years 

ago, the early man used to draw pictures of the animals they hunted on the walls of caves. 

These animal drawings are track lines and tallies thought to depict migration routes. While 
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simplistic in comparison to modern technologies, these early records mimic the two-element 

structure of modern geographic information systems, an image associated with attribute 

information.  

Possibly the earliest use of the geographic method, in 1854 John Snow depicted a 

cholera outbreak in London using points to represent the locations of some individual cases. 

His study of the distribution of cholera led to the source of the disease, a contaminated water 

pump within the heart of the cholera outbreak. While the basic elements of topology and theme 

existed previously in cartography, the John Snow map was unique, using cartographic 

methods, not only to depict but also to analyze, clusters of geographically dependent 

phenomena for the first time.  

The early 20th century saw the development of "photo lithography" where maps were 

separated into layers. Computer hardware development spurred by nuclear weapon research 

led to general-purpose computer "mapping" applications by the early 1960s. In the year 1962, 

the world's first true operational GIS was developed by the federal Department of Forestry 

and Rural Development in Ottawa, Canada by Dr. Roger Tomlinson. It was called the "Canada 

Geographic Information System" (CGIS) and was used to store, analyze, and manipulate data 

collected for the Canada Land Inventory (CLI). It is an initiative to determine the land 

capability for rural Canada by mapping information about soils, agriculture, recreation, 

wildlife, forestry, and land use at a scale of 1:50,000. 

CGIS was the world's first "system" and was an improvement over "mapping" 

applications as it provided capabilities for overlay, measurement, and digitizing or scanning. 

It supported a national coordinate system that spanned the continent, coded lines as "arcs" 

having a true embedded topology, and it stored the attribute and location specific information 

in a separate files. Dr. Tomlinson is known as the "father of GIS," for his use of overlays in 

promoting the spatial analysis of convergent geographic data. 

 In 1964, Howard T Fisher formed the Laboratory for Computer Graphics and Spatial 

Analysis at the Harvard Graduate School of Design, where a number of important theoretical 

concepts in spatial data handling were developed. This lab had major influence on the 

development of GIS until early 1980s. Many pioneers of newer GIS "grew up" at the Harvard 

lab and had distributed seminal software code and systems, such as 'SYMAP', 'GRID', and 

'ODYSSEY'.  

By the early 1980s, M&S Computing (later Intergraph), Environmental Systems 

Research Institute (ESRI) and CARIS emerged as commercial vendors of GIS software, 

successfully incorporating many of the CGIS features, combining the first generation 

approach to separation of spatial and attribute information with a second generation approach 

to organizing attribute data into database structures. More functions for user interaction were 

developed mainly in a graphical way by a user friendly interface (Graphical User Interface), 

which gave to the user the ability to sort, select, extract, reclassify, reproject and display data 

on the basis of complex geographical, topological and statistical criteria. During the same 

time, the development of a public domain GIS begun by the U.S. Army Corp of Engineering 

Research Laboratory (USA-CERL) in Champaign, Illinois, a branch of the U.S. Army Corps 
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of Engineers to meet the need of the United States military for software for land management 

and environmental planning.  

In the years 1980s and 1990s industry growth were spurred on by the growing use of 

GIS on Unix workstations and the personal computers. By the end of the 20th century, the 

rapid growth in various systems had been consolidated and standardized on relatively few 

platforms and users were beginning to export the concept of viewing GIS data over the 

Internet, requiring uniform data format and transfer standards. More recently, there is a 

growing number of free, open source GIS packages, which run on a range of operating systems 

and can be customized to perform specific tasks. As computing power increased and hardware 

prices slashed down, the GIS became a viable technology for state development planning. It 

has become a real Management Information System (MIS), and thus able to support decision 

making processes.  

Components of GIS 

  GIS enables the user to input, manage, manipulate, analyze, and display 

geographically referenced data using a computerized system. To perform various operations 

with GIS, the components of GIS such as software, hardware, data, people and methods are 

essential. 

 1. Software   

GIS software provides the functions and tools needed to store, analyze, and display 

geographic information. Key software components are (a) a database management system 

(DBMS) (b) tools for the input and manipulation of geographic information (c) tools that 

support geographic query, analysis, and visualization (d) a graphical user interface (GUI) for 

easy access to tools. GIS software are either commercial software or software developed on 

Open Source domain, which are available for free. However, the commercial software is 

copyright protected, can be expensive and is available in terms number of licensees. 

Currently available commercial GIS software includes ArcGIS, ARCPRO, 

Intergraph, MapInfo, Gram++ etc. Out of these ArcPRO is the most popular software 

package. And, the open source software are QGIS, DIVA GIS, AMS/MARS etc.  

2. Hardware  

Hardware is the computer on which a GIS operates. Today, GIS runs on a wide range 

of hardware types, from centralized computer servers to desktop computers used in stand-

alone or networked configurations 

3. Data  

The most important component of a GIS is the data. Geographic data or Spatial data 

and related tabular data can be collected in-house or bought from a commercial data provider. 

Spatial data can be in the form of a map/remotely-sensed data such as satellite imagery and 

aerial photography. These data forms must be properly geo referenced (latitude/longitude). 

Tabular data can be in the form attribute data that is in some way related to spatial data. Most 
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GIS software comes with inbuilt Database Management Systems (DBMS) to create and 

maintain a database to help organize and manage data.  

4. Users  

GIS technology is of limited value without the users who manage the system and to 

develop plans for applying it. GIS users range from technical specialists who design and 

maintain the system to those who use it to help them do their everyday work. 

These users are largely interested in the results of the analyses and may have no interest 

or knowledge of the methods of analysis. The user-friendly interface of the GIS software 

allows the nontechnical users to have easy access to GIS analytical capabilities without 

needing to know detailed software commands. A simple User Interface (UI) can consist of 

menus and pull-down graphic windows so that the user can perform required analysis with a 

few key presses without needing to learn specific commands in detail.  

5. Methods  

A successful GIS operates according to a well-designed plan and business rules, 

which are the models and operating practices unique to each organization.  

Functions of GIS  

General-purpose GIS software performs six major tasks such as input, manipulation, 

management, query and analysis, Visualization.  

1. Input  

The important input data for any GIS is digitized maps, images, spatial data and tabular 

data. The tabular data is generally typed on a computer using relational database management 

system software. Before geographic data can be used in a GIS it must be converted into a 

suitable digital format. The DBMS system can generate various objects such as index 

generation on data items, to speed up the information retrieval by a query. Maps can be 

digitized using a vector format in which the actual map points, lines, and polygons are stored 

as coordinates. Data can also be input in a raster format in which data elements are stored as 

cells in a grid structure (the technology details are covered in following section).  

The process of converting data from paper maps into computer files is called digitizing. 

Modern GIS technology has the capability to automate this process fully for large projects; 

smaller jobs may require some manual digitizing. The digitizing process is labour intensive 

and time-consuming, so it is better to use the data that already exist.Today many types of 

geographic data already exist in GIS-compatible formats. These data can be obtained from 

data suppliers and loaded directly into a GIS.  

2. Manipulation  

GIS can store, maintain, distribute and update spatial data associated text data. The 

spatial data must be referenced to a geographic coordinate systems (latitude/longitude). The 

tabular data associated with spatial data can be manipulated with help of data base 



ICAR-DCFR 01-2025 
 

27 | C o l d w a t e r  r e s o u r c e  m a p p i n g  u s i n g  g e o s p a t i a l  t o o l s ,  1 9 -
2 1  F e b ,  2 0 2 5  
 

management software. It is likely that data types required for a particular GIS project will need 

to be transformed or manipulated in some way to make them compatible with the system. For 

example, geographic information is available at different scales (scale of 1:100,000; 1:10,000; 

and 1:50,000). Before these can be overlaid and integrated they must be transformed to the 

same scale. This could be a temporary transformation for display purposes or a permanent one 

required for analysis. And, there are many other types of data manipulation that are routinely 

performed in GIS. These include projection changes, data aggregation, generalization and 

weeding out unnecessary data.  

3. Management  

For small GIS projects it may be sufficient to store geographic information as computer 

files. However, when data volumes become large and the number of users of the data becomes 

more than a few, it is advised to use a database management system (DBMS) to help store, 

organize, and manage data. A DBMS is a database management software package to manage 

the integrated collection of database objects such as tables, indexes, query, and other 

procedures in a database.  

There are many different models of DBMS, but for GIS use, the relational model 

database management systems will be highly helpful. In the relational model, data are stored 

conceptually as a collection of tables and each table will have the data attributes related to a 

common entity. Common fields in different tables are used to link them together with relations. 

Because of its simple architecture, the relational DBMS software has been used so widely. 

These are flexible in nature and have been very wide deployed in applications both within and 

without GIS. 

4. Query  

The stored information either spatial data or associated tabular data can be retrieved with 

the help of Structured Query Language (SQL). Depending on the type of user interface, data 

can be queried using the SQL or a menu driven system can be used to retrieve map data. For 

example, you can begin to ask questions such as:  

• Where are all the soils are suitable for sunflower crop?  

• What is the dominant soil type for Paddy? 

• What is the groundwater available position in a village/block/district?  

Both simple and sophisticated queries utilizing more than one data layer can provide timely 

information to officers, analysts to have overall knowledge about situation and can take a 

more informed decision.  

5. Analysis  

GIS systems really come into their own when they are used to analyze geographic 

data. The processes of geographic analysis often called spatial analysis or geo-processing 

uses the geographic properties of features to look for patterns and trends, and to undertake 

"what if" scenarios. Modern GIS have many powerful analytical tools to analyse the data. 
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a. Overlay Analysis 

The integration of different data layers involves a process called overlay. At its 

simplest, this could be a visual operation, but analytical operations require one or more data 

layers to be joined physically. This overlay, or spatial join, can integrate data on soils, slope, 

and vegetation, or land ownership. For example, data layers for soil and land use can be 

combined resulting in a new map which contains both soil and land use information. This will 

be helpful to understand the different behaviour of the situation on different parameters.  

b. Proximity Analysis  

GIS software can also support buffer generation that involves the creation of new 

polygons from points, lines, and polygon features stored in the database. For example, to know 

answer to questions like; How much area covered within 1 km of water canal? What is area 

covered under different crops? And, for watershed projects, where is the boundary or 

delineation of watershed, slope, water channels, different types water harvesting structures are 

required, etc.  

6. Visualization  

GIS can provide hardcopy maps, statistical summaries, modeling solutions and 

graphical display of maps for both spatial and tabular data. For many types of geographic 

operation the end result is best visualized as a map or graph. Maps are very efficient at storing 

and communicating geographic information. GIS provides new and exciting tools to extend 

the art of visualization of output information to the users. 

Technology used in GIS 

Data creation  

Modern GIS technologies use digital information, for which various digitized data 

creation methods are used. The most common method of data creation is digitization, where a 

hard copy map or survey plan is transferred into a digital medium through the use of a 

computer-aided design program with geo-referencing capabilities. With the wide availability 

of rectified imagery (both from satellite and aerial sources), heads-up digitizing is becoming 

the main avenue through which geographic data is extracted. Heads-up digitizing involves the 

tracing of geographic data directly on top of the aerial imagery instead of through the 

traditional method of tracing the geographic form on a separate digitizing tablet. 

Data representation 

 GIS data represents real world objects such as roads, land use, elevation with digital 

data. Real world objects can be divided into two abstractions: discrete objects (a house) and 

continuous fields (rain fall amount or elevation). There are two broad methods used to store 

data in a GIS for both abstractions: Raster and Vector. 

a. Raster  
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A raster data type is, in essence, any type of digital image. Anyone who is familiar with 

digital photography will recognize the pixel as the smallest individual unit of an image. A 

combination of these pixels will create an image, distinct from the commonly used scalable 

vector graphics, which are the basis of the vector model. While a digital image is concerned 

with the output as representation of reality, in a photograph or art transferred to computer, the 

raster data type will reflect an abstraction of reality. Aerial photos are one commonly used 

form of raster data, with only one purpose, to display a detailed image on a map or for the 

purposes of digitization. Other raster data sets will contain information regarding elevation, a 

DEM (digital Elevation Model), or reflectance of a particular wavelength of light. 

Digital elevation model, map, and vector data, Raster data type consists of rows and 

columns of cells each storing a single value. Raster data can be images (raster images) with 

each pixel containing a color value. Additional values recorded for each cell may be a discrete 

value, such as land use, a continuous value, such as temperature, or a null value if no data is 

available. While a raster cell stores a single value, it can be extended by using raster bands to 

represent RGB (red, green, blue) colors, colormaps (a mapping between a thematic code and 

RGB value), or an extended attribute table with one row for each unique cell value. The 

resolution of the raster data set is its cell width in ground units.  

Raster data is stored in various formats; from a standard file-based structure of TIF, 

JPEG formats to binary large object (BLOB) data stored directly in a relational database 

management system (RDBMS) similar to other vector-based feature classes. Database storage, 

when properly indexed, typically allows for quicker retrieval of the raster data but can require 

storage of millions of significantly sized records.  

b. Vector  

A simple vector map, using each of the vector elements: points for wells, lines for 

rivers, and a polygon for the lake. In a GIS, geographical features are often expressed as 

vectors, by considering those features as geometrical shapes. In the popular ESRI Arc series 

of programs, these are explicitly called shape files. Different geographical features are best 

expressed by different types of geometry:  

1. Points 

  Zero-dimensional points are used for geographical features that can best be expressed 

by a single grid reference; in other words, simple location. For example, the locations of wells, 

peak elevations, features of interest or trailheads. Points convey the least amount of 

information of these file types.  

2. Lines or polylines  

One-dimensional lines or polylines are used for linear features such as rivers, roads, 

railroads, trails, and topographic lines. 

3. Polygons  
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Two-dimensional polygons are used for geographical features that cover a particular 

area of the earth's surface. Such features may include lakes, park boundaries, buildings, city 

boundaries, or land uses. Polygons convey the most amount of information of the file types.  

Each of these geometries are linked to a row in a database that describes their 

attributes. For example, a database that describes lakes may contain a lake's depth, water 

quality, pollution level. This information can be used to make a map to describe a particular 

attribute of the dataset. For example, lakes could be coloured depending on level of pollution. 

Different geometries can also be compared. For example, the GIS could be used to identify all 

wells (point geometry) that are within 1-mile (1.6 km) of a lake (polygon geometry) that has 

a high level of pollution. 
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Introduction 

The Global Positioning System (GPS) has revolutionized various sectors, including 

agriculture, transportation, and environmental monitoring. One of the most significant 

applications of GPS technology is in the management and sustainable utilization of fishery 

resources. This chapter explores the diverse applications of GPS in fisheries, highlighting its 

role in enhancing efficiency, sustainability, and safety in the fishing industry. 

GPS Technology: An Overview 

GPS is a satellite-based navigation system that provides geolocation and time 

information to a GPS receiver anywhere on or near the Earth. The system consists of a 

constellation of at least 24 satellites orbiting the Earth, ground control stations, and GPS 

receivers. The satellites transmit signals that allow GPS receivers to determine their exact 

location (latitude, longitude, and altitude) and the precise time. 

Working of GPS 

1. Satellite Constellation: GPS satellites orbit the Earth at an altitude of approximately 

20,200 kilometers. Each satellite transmits a unique signal and orbital parameters that 

allow GPS receivers to decode and compute the precise location of the satellite. 

2. Signal Transmission: The GPS receiver calculates the distance to each satellite by 

measuring the time delay between the transmission and reception of the signal. With 

signals from at least four satellites, the receiver can determine its three-dimensional 

position (latitude, longitude, and altitude). 

3. Position Calculation: Using trilateration, the GPS receiver combines the distance 

measurements from multiple satellites to compute its exact location. 
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Fig: GPS Satellite Constellation 

Applications of GPS in Fisheries  

1. Navigation and Fleet Management 

One of the primary applications of GPS in fisheries is navigation. Fishing vessels equipped 

with GPS receivers can accurately determine their position, even in the open sea where 

landmarks are absent. This capability is crucial for: 

• Route Optimization: GPS enables fishermen to plot the most efficient routes to 

fishing grounds, reducing fuel consumption and travel time. 

• Safety: In case of emergencies, such as engine failure or severe weather, GPS allows 

for precise location reporting, facilitating rapid rescue operations. 

• Fleet Tracking: Fisheries management authorities can monitor the movement of 

fishing vessels in real-time, ensuring compliance with regulations and preventing 

illegal fishing activity 
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Fig: GPS Navigation System on a Fishing Vessel 

 

2. Fish Stock Assessment and Habitat Mapping 

GPS technology is instrumental in fish stock assessment and habitat mapping. By 

combining GPS data with other technologies such as Geographic Information Systems (GIS) 

and sonar, researchers can: 

• Map Fishing Grounds: GPS allows for the precise mapping of fishing grounds, 

including the location of fish schools, coral reefs, and other underwater features. 

• Monitor Fish Movements: Acoustic tags equipped with GPS can track the 

movements of fish, providing valuable data on migration patterns, spawning grounds, 

and habitat preferences. 

• Assess Stock Levels: By integrating GPS data with catch records, researchers can 

estimate fish stock levels and assess the health of fish populations. 
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3. Sustainable Fishing Practices 

GPS plays a critical role in promoting sustainable fishing practices. By providing 

accurate data on fishing activities, GPS helps in: 

• Avoiding Overfishing: Real-time monitoring of fishing activities allows authorities 

to enforce catch limits and prevent overfishing in sensitive areas. 

• Reducing Bycatch: GPS can be used to identify areas with high bycatch rates, 

enabling fishermen to avoid these zones and reduce unintended catch of non-target 

species. 

• Marine Protected Areas (MPAs): GPS data is used to establish and monitor MPAs, 

ensuring that these critical habitats are protected from fishing activities. 

 
Fig: GPS-Enabled Sustainable Fishing Practices 

 

 

 

 

 

               Fig: Fish Stock Assessment Using GPS and Sonar Technology 
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4. Aquaculture Management 

In aquaculture, GPS technology is used to optimize the location and management of fish 

farms. Key applications include: 

• Site Selection: GPS data helps in selecting optimal sites for fish farms, considering 

factors such as water quality, depth, and proximity to markets. 

• Cage Positioning: GPS is used to precisely position fish cages, ensuring they are 

placed in areas with favorable environmental conditions. 

• Environmental Monitoring: GPS-enabled sensors can monitor water temperature, 

salinity, and other parameters, providing real-time data for effective farm 

management. 

5. Illegal, Unreported, and Unregulated (IUU) Fishing Monitoring 

IUU fishing is a significant threat to global fish stocks. GPS technology is a powerful tool 

in combating IUU fishing by: 

• Vessel Monitoring Systems (VMS): GPS-based VMS allows authorities to track the 

location and activities of fishing vessels, ensuring compliance with fishing regulations. 

• Electronic Reporting: GPS data can be integrated with electronic reporting systems, 

providing accurate and timely information on catch volumes and fishing locations. 

• Enforcement: GPS data can be used as evidence in legal proceedings against vessels 

engaged in IUU fishing. 

Challenges and Future Directions 

While GPS technology has transformed the fishing industry, several challenges remain: 

• Cost: The initial cost of GPS equipment and ongoing maintenance can be prohibitive 

for small-scale fishermen. 

• Data Accuracy: Environmental factors such as atmospheric conditions and signal 

interference can affect GPS accuracy. 

• Data Management: The large volume of data generated by GPS systems requires 

robust data management and analysis tools. 

Future advancements in GPS technology, such as the integration of Artificial Intelligence 

(AI) and Machine Learning (ML), are expected to further enhance its applications in 

fisheries. These technologies could enable predictive analytics, improving decision-

making in fish stock management and sustainable fishing practices 
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Introduction  

GIS (Geographic Information System) software is a specialized tool that allows users 

to capture, store, analyze, and visualize spatial or geographic data. It integrates various data 

types, including maps, satellite imagery, and tabular information, to provide insights into 

spatial relationships, patterns, and trends. 

GIS software is used in diverse fields such as urban planning, environmental 

management, transportation, agriculture, disaster management, and business intelligence. 

Types of GIS Software 

GIS software can be categorized into several types based on functionality and 

application: 

• Desktop GIS 

o Standalone applications installed on a local computer. 

o Provide robust spatial analysis, data processing, and visualization tools. 

o Examples: ArcGIS Pro, QGIS, MapInfo Pro, GRASS GIS. 

• Web GIS 

o Cloud-based GIS solutions accessible via web browsers. 

o Support collaborative mapping, real-time data sharing, and online geospatial 

analysis. 

o Examples: ArcGIS Online, Google Earth Engine, Mapbox. 

• Server GIS 

o Enterprise-level GIS that allows multiple users to access and analyze spatial 

data remotely. 

o Used for large-scale applications, integrating GIS with databases and web 

services. 

o Examples: ArcGIS Server, GeoServer, MapServer. 

• Mobile GIS 

o GIS applications designed for field data collection and analysis using 

smartphones or tablets. 

o Used in agriculture, forestry, and infrastructure monitoring. 

o Examples: ArcGIS Field Maps, QField, Locus Map. 

• Remote Sensing GIS 

o Specialized GIS software used for analyzing satellite imagery and aerial 

photography. 
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o Supports raster data processing, land use classification, and environmental 

monitoring. 

o Examples: ERDAS IMAGINE, ENVI, Google Earth Engine. 

Detailed Description of Existing GIS Software 

Here’s a comprehensive list of GIS software, including their features, system requirements, 

and cost: 

1. ArcGIS Pro (Commercial) 

• Developer: Esri 

• Description: ArcGIS Pro is a leading GIS desktop software that offers advanced 

spatial analysis, 2D/3D visualization, and geoprocessing tools. 

• Key Features: 

o 3D visualization with ArcGIS Scene 

o AI-powered spatial analysis 

o Integration with ArcGIS Online and Server 

• System Requirements: 

o OS: Windows 10 or later 

o Processor: 2.2 GHz+ 

o RAM: 8GB (16GB recommended) 

o Storage: 32GB free space 

• Cost: Subscription-based, starting at ~$100/year for personal use, higher for 

enterprise plans. 

2. QGIS (Open Source) 

• Developer: Open Source Geospatial Foundation (OSGeo) 

• Description: QGIS is a free, open-source GIS software offering extensive features 

for spatial analysis and data visualization. 

• Key Features: 

o Supports multiple GIS data formats 

o Plugin architecture for customization 

o Integration with Python and R for geospatial scripting 

• System Requirements: 

o OS: Windows, macOS, Linux 
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o Processor: 1 GHz+ 

o RAM: 4GB (8GB recommended) 

o Storage: 2GB free space 

• Cost: Free 

3. MapInfo Pro (Commercial) 

• Developer: Precisely (formerly Pitney Bowes) 

• Description: MapInfo Pro is a powerful desktop GIS solution used in business 

analytics and urban planning. 

• Key Features: 

o User-friendly interface 

o Advanced geospatial analytics 

o Spatial SQL support 

• System Requirements: 

o OS: Windows 10 or later 

o Processor: 2 GHz+ 

o RAM: 4GB (8GB recommended) 

o Storage: 2GB free space 

• Cost: Subscription-based, pricing available upon request. 

4. Maptitude (Commercial) 

• Developer: Caliper Corporation 

• Description: Maptitude is a business-focused GIS software designed for market 

analysis and spatial data visualization. 

• Key Features: 

o Built-in demographic and business datasets 

o Route optimization 

o Geocoding and spatial analytics 

• System Requirements: 

o OS: Windows 10 or later 

o Processor: 1 GHz+ 

o RAM: 4GB (8GB recommended) 



ICAR-DCFR 01-2025 
 

39 | C o l d w a t e r  r e s o u r c e  m a p p i n g  u s i n g  g e o s p a t i a l  t o o l s ,  1 9 -
2 1  F e b ,  2 0 2 5  
 

o Storage: 10GB free space 

• Cost: One-time purchase, ~$695. 

 

5. GRASS GIS (Open Source) 

• Developer: GRASS Development Team 

• Description: GRASS GIS is a powerful open-source GIS application widely used in 

environmental modeling and remote sensing. 

• Key Features: 

o Advanced raster and vector processing 

o Python and R integration 

o 3D terrain analysis 

• System Requirements: 

o OS: Windows, macOS, Linux 

o Processor: 1 GHz+ 

o RAM: 4GB (8GB recommended) 

o Storage: 2GB free space 

• Cost: Free 

6. Google Earth Pro (Free) 

• Developer: Google 

• Description: Google Earth Pro is a 3D mapping application with satellite imagery, 

terrain data, and geospatial measurements. 

• Key Features: 

o Historical satellite imagery 

o 3D globe visualization 

o Basic GIS tools for area measurement and overlays 

• System Requirements: 

o OS: Windows, macOS 

o Processor: 1 GHz+ 

o RAM: 4GB+ 

o Storage: 2GB free space 
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• Cost: Free 

7. ArcGIS Online (Commercial Web GIS) 

• Developer: Esri 

• Description: A cloud-based GIS for creating, sharing, and analyzing spatial data in a 

web environment. 

• Key Features: 

o Cloud-based map hosting 

o Collaboration tools 

o Integration with mobile and desktop GIS 

• Cost: Subscription-based, starting at ~$100 per year. 

8. Google Earth Engine (Web-based Remote Sensing GIS) 

• Developer: Google 

• Description: A cloud-based platform for analyzing large-scale geospatial data, 

including satellite imagery and environmental datasets. 

• Key Features: 

o Access to global satellite imagery archives 

o Machine learning integration for geospatial analysis 

o API for Python and JavaScript 

• Cost: Free for research and educational purposes; pricing for enterprise use varies. 

9. ENVI (Commercial Remote Sensing GIS) 

• Developer: L3Harris Geospatial 

• Description: ENVI specializes in remote sensing data processing, used extensively 

in land use analysis and environmental monitoring. 

• Key Features: 

o Hyperspectral and multispectral image processing 

o AI-based geospatial analysis 

o SAR (Synthetic Aperture Radar) processing 

• System Requirements: 

o OS: Windows 10 or later 

o RAM: 8GB+ 



ICAR-DCFR 01-2025 
 

41 | C o l d w a t e r  r e s o u r c e  m a p p i n g  u s i n g  g e o s p a t i a l  t o o l s ,  1 9 -
2 1  F e b ,  2 0 2 5  
 

o Storage: 20GB+ 

• Cost: Custom pricing based on licensing model. 

10. GeoServer (Open-Source Server GIS) 

• Developer: OSGeo 

• Description: GeoServer is an open-source platform for publishing geospatial data 

via web services. 

• Key Features: 

o Supports OGC standards (WMS, WFS, WCS) 

o Integration with PostGIS database 

o Web mapping API support 

• System Requirements: 

o OS: Windows, Linux, macOS 

o RAM: 4GB+ 

o Requires Java environment 

• Cost: Free 
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Introduction  

Satellite data refers to information collected by artificial satellites orbiting Earth. These 

satellites capture images, atmospheric readings, and geospatial data using advanced sensors 

such as optical cameras, radar, and infrared detectors. The data can be in different formats, 

including: 

• Optical imagery (e.g., Landsat, Sentinel-2) 

• Radar (SAR) data (e.g., Sentinel-1, RADARSAT) 

• Thermal data (e.g., MODIS, ASTER) 

• Elevation data (e.g., SRTM, LiDAR) 

• Atmospheric data (e.g., Sentinel-5P, GOES) 

Satellite data comes in different formats based on the type of sensor and the nature of the 

data. The most common formats include optical imagery, radar (SAR) data, thermal data, 

elevation data, and atmospheric data. Below is a detailed explanation of each category, 

including key satellite missions, data formats, and use cases. 

1. Optical Imagery (e.g., Landsat, Sentinel-2) 

Optical imagery is satellite data captured in the visible and infrared spectrum. These 

images resemble photographs taken from space and are often used for land cover mapping, 

vegetation monitoring, and urban planning. 

Key Satellites 

• Landsat Series (Landsat 1-9) – Operated by NASA/USGS, provides 30m resolution 

multispectral data. 

• Sentinel-2 (A & B) – Operated by ESA, provides 10m–60m resolution multispectral 

data. 

• MODIS (Moderate Resolution Imaging Spectroradiometer) – Provides 250m–1km 

resolution imagery for global environmental monitoring. 

• SPOT (Satellite Pour l’Observation de la Terre) – High-resolution optical imagery 

(1.5m to 6m). 

• WorldView & QuickBird (Commercial) – Ultra-high-resolution (30cm) optical 

imagery for detailed analysis. 

mailto:parvaiz.ganie@icar.gov.in
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Data Formats 

• GeoTIFF (.tif) – Most common format, georeferenced for GIS applications. 

• HDF (Hierarchical Data Format) – Used for MODIS and ASTER data, supports large 

datasets. 

• NetCDF (Network Common Data Form) – Used for climate and atmospheric studies. 

• JPEG2000 (.jp2) – Used in Sentinel-2 data, provides efficient compression. 

Applications 

• Land use & land cover (LULC) classification 

• Forest and vegetation monitoring 

• Urban expansion and infrastructure planning 

• Agriculture and crop health assessment 

• Water body mapping 

2. Radar (SAR) Data (e.g., Sentinel-1, RADARSAT) 

Synthetic Aperture Radar (SAR) data uses microwave signals to capture images of the Earth’s 

surface. Unlike optical sensors, SAR can penetrate clouds, operate in darkness, and detect 

surface changes. 

Key Satellites 

• Sentinel-1 (A & B) – European SAR satellites with C-band radar (5m–20m 

resolution). 

• RADARSAT (1, 2, and RCM) – Canadian SAR satellites for flood, ice, and disaster 

monitoring. 

• ALOS PALSAR (Advanced Land Observing Satellite – Phased Array L-band SAR) 

– High-resolution radar data. 

• TerraSAR-X & TanDEM-X – High-resolution commercial radar satellites (1m–3m). 

Data Formats 

• GeoTIFF (.tif) – Standard format for SAR images. 

• GRD (Ground Range Detected) – Pre-processed SAR images with radiometric and 

geometric corrections. 

• SLC (Single Look Complex) – Contains both amplitude and phase information, used 

for interferometry. 

• HDF5 (.h5) – Used in advanced radar datasets. 
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Applications 

• Flood mapping and disaster response 

• Landslide and earthquake deformation analysis 

• Deforestation monitoring 

• Infrastructure change detection 

• Glacier and sea ice monitoring 

3. Thermal Data (e.g., MODIS, ASTER) 

Thermal sensors capture infrared radiation emitted from the Earth’s surface. This data is used 

to measure land and sea surface temperatures, detect wildfires, and analyze urban heat islands. 

Key Satellites 

• MODIS (Terra & Aqua) – Provides 1km resolution global thermal imagery. 

• ASTER (Advanced Spaceborne Thermal Emission and Reflection Radiometer) – 

Offers 90m resolution thermal data. 

• Landsat 8-9 (TIRS – Thermal Infrared Sensor) – Measures surface temperature at 

100m resolution. 

• GOES (Geostationary Operational Environmental Satellite) – Provides real-time 

weather and thermal infrared data. 

Data Formats 

• GeoTIFF (.tif) – Used for temperature anomaly analysis. 

• HDF (.hdf) – Supports multi-band storage (e.g., MODIS data). 

• NetCDF (.nc) – Used for atmospheric and oceanic temperature data. 

Applications 

• Wildfire detection and monitoring 

• Urban heat island analysis 

• Sea surface temperature monitoring 

• Geothermal activity and volcano monitoring 

• Drought assessment 

4. Elevation Data (e.g., SRTM, LiDAR) 

Elevation data provides digital elevation models (DEMs) representing Earth’s surface 

topography. It is critical for hydrology, land planning, and infrastructure development. 
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Key Datasets & Satellites 

• SRTM (Shuttle Radar Topography Mission) – Provides 30m and 90m resolution 

DEMs. 

• LiDAR (Light Detection and Ranging) – Airborne sensors providing high-resolution 

1m–10m elevation data. 

• ALOS PALSAR DEM – Provides global 12.5m resolution elevation models. 

• TanDEM-X DEM – High-resolution global elevation model (12m). 

Data Formats 

• GeoTIFF (.tif) – Standard format for elevation models. 

• ASCII Grid (.asc) – Text-based format for DEMs. 

• LAS (.las) & LAZ (.laz) – Used for LiDAR point cloud data. 

• DTED (Digital Terrain Elevation Data) – Military-grade elevation format. 

Applications 

• Flood risk modeling and hydrology 

• 3D terrain visualization and mapping 

• Landslide and erosion studies 

• Infrastructure and urban planning 

5. Atmospheric Data (e.g., Sentinel-5P, GOES) 

Atmospheric data measures air quality, greenhouse gases, and meteorological parameters. It 

is crucial for climate science, pollution monitoring, and weather forecasting. 

Key Satellites 

• Sentinel-5P (TROPOMI Instrument) – Measures air pollution (CO₂, NO₂, O₃, SO₂, 

aerosols). 

• GOES (Geostationary Operational Environmental Satellite) – Provides real-time 

meteorological and cloud cover data. 

• MODIS (Terra & Aqua) – Monitors atmospheric aerosols, dust, and cloud properties. 

• OMI (Ozone Monitoring Instrument) – Tracks ozone layer depletion and UV 

radiation. 

Data Formats 

• NetCDF (.nc) – Standard for atmospheric and climate data. 

• HDF5 (.h5) – Used for Sentinel-5P and MODIS datasets. 
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• BUFR (Binary Universal Form for the Representation of meteorological data) – Used 

for weather models. 

Applications 

• Air quality and pollution monitoring 

• Ozone layer depletion analysis 

• Greenhouse gas tracking (CO₂, CH₄, NO₂) 

• Weather forecasting and climate modeling 

• Dust storm and wildfire smoke detection 

 

Summary 

Data Type Key Satellites Best Format Applications 

Optical Landsat, Sentinel-2 GeoTIFF, HDF Land cover, urban planning 

Radar (SAR) 
Sentinel-1, 

RADARSAT 
SLC, GRD 

Flood mapping, surface 

deformation 

Thermal MODIS, ASTER HDF, GeoTIFF Wildfires, sea surface temperature 

Elevation SRTM, LiDAR GeoTIFF, LAS Flood modeling, 3D mapping 

Atmospheric Sentinel-5P, GOES NetCDF, HDF Air pollution, weather forecasting 
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Introduction  

There are numerous platforms available for downloading satellite data, offering 

different types of imagery, spatial resolutions, temporal coverage, and data processing tools. 

Below is a comprehensive list of the best free and commercial satellite data download 

resources, along with their features. 

Free Satellite Data Download Resources 

1. USGS Earth Explorer 

Website: https://earthexplorer.usgs.gov/ 

Features: 

• Provides access to Landsat (1-9), Sentinel-2, MODIS, ASTER, and other datasets. 

• Allows search based on date, region, and cloud cover. 

• Offers multiple file formats (GeoTIFF, HDF, NetCDF). 

• Supports bulk downloading via scripts or manual selection. 

Best For: 

• Researchers and analysts needing medium-resolution imagery (10m–30m). 

• Environmental monitoring, land use/land cover studies, and disaster response. 

2. Copernicus Open Access Hub (Sentinel Data) 

Website: https://scihub.copernicus.eu/ 

Features: 

• Provides Sentinel-1 (SAR), Sentinel-2 (Optical), Sentinel-3 (Ocean and Land), and 

Sentinel-5P (Atmosphere) data. 

• Global coverage with high temporal resolution (revisit times of 5–10 days). 

• Free and open access for research and operational use. 

• Multi-spectral and Synthetic Aperture Radar (SAR) capabilities. 

Best For: 

• Vegetation monitoring, flood detection, land classification, and atmospheric studies. 
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3. NASA Earthdata Search 

Website: https://search.earthdata.nasa.gov/ 

Features: 

• Offers MODIS, VIIRS, ASTER, GEDI, SMAP, and ICESat-2 data. 

• Provides on-demand processing and subsetting services. 

• Data available in multiple formats including NetCDF, HDF, and GeoTIFF. 

• Search and filter by parameters like time range, location, and dataset type. 

Best For: 

• Climate studies, oceanography, and atmospheric research. 

4. Google Earth Engine (GEE) 

Website: https://earthengine.google.com/ 

Features: 

• Cloud-based platform offering access to petabytes of satellite data. 

• Includes datasets from Landsat, Sentinel, MODIS, and climate models. 

• Supports real-time geospatial analysis with JavaScript and Python APIs. 

• No need for downloads; computations run in the cloud. 

Best For: 

• Large-scale data analysis, machine learning in remote sensing, and real-time 

environmental monitoring. 

5. NOAA CLASS (National Oceanic and Atmospheric Administration) 

Website: https://www.class.noaa.gov/ 

Features: 

• Provides meteorological and oceanographic data from NOAA satellites (GOES, 

JPSS, POES, AVHRR). 

• High temporal resolution satellite data for weather monitoring. 

• Data available in NetCDF and HDF formats. 

Best For: 

• Weather forecasting, climate change analysis, and disaster response. 

6. Alaska Satellite Facility (ASF DAAC - SAR Data) 

Website: https://search.asf.alaska.edu/ 

https://search.earthdata.nasa.gov/
https://earthengine.google.com/
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Features: 

• Specializes in Synthetic Aperture Radar (SAR) imagery from Sentinel-1, ALOS 

PALSAR, UAVSAR, and RADARSAT. 

• Offers high-resolution radar data for all-weather, day/night imaging. 

• Provides access to cloud computing via the HyP3 platform for SAR data processing. 

Best For: 

• Glacier movement analysis, flood mapping, and deforestation monitoring. 

7. Global Land Cover Facility (GLCF) 

Website: https://glcf.umd.edu/ 

Features: 

• Free access to Landsat, MODIS, and AVHRR land cover datasets. 

• Supports time-series land use/land cover analysis. 

• Offers pre-processed vegetation indices and climate datasets. 

Best For: 

• Land cover classification, deforestation studies, and ecological monitoring. 

 

8. LP DAAC (Land Processes Distributed Active Archive Center) 

Website: https://lpdaac.usgs.gov/ 

Features: 

• Offers ASTER, MODIS, VIIRS, GEDI, and SRTM datasets. 

• Provides on-the-fly subsetting and reformatting. 

• Integrated with NASA’s Earthdata Search for easier access. 

Best For: 

• Land surface temperature, vegetation monitoring, and topographic mapping. 

9. Radiant Earth Foundation 

Website: https://www.radiant.earth/ 

Features: 

• Open-access geospatial datasets for AI and machine learning applications. 

• Provides training datasets for deep learning in remote sensing. 

https://www.radiant.earth/
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• Supports cloud-native processing. 

Best For: 

• Machine learning applications in remote sensing and geospatial AI development. 

10. Digital Earth Africa 

Website: https://www.digitalearthafrica.org/ 

Features: 

• Open-access satellite data platform tailored for Africa. 

• Provides Sentinel-2, Landsat, and MODIS imagery. 

• Supports analysis of water bodies, agriculture, and urban expansion. 

Best For: 

• Climate resilience, agricultural monitoring, and sustainable development in Africa. 

Commercial Satellite Data Providers 

While free sources provide high-quality imagery, commercial providers offer higher 

resolution (sub-meter) and on-demand data acquisition. 

1. Maxar (DigitalGlobe) 

Website: https://www.maxar.com/ 

Features: 

• Very high-resolution (30 cm) imagery from WorldView, GeoEye, and QuickBird 

satellites. 

• Tasking services allow custom satellite image acquisition. 

• Used for defense, mapping, and disaster response. 

2. Airbus OneAtlas 

Website: https://oneatlas.airbus.com/ 

Features: 

• Provides imagery from Pleiades, SPOT, and TerraSAR-X satellites. 

• AI-powered image analysis for change detection. 

• High-resolution (50 cm to 1.5 m) optical and SAR data. 

3. Planet Labs 

Website: https://www.planet.com/ 

Features: 

https://www.digitalearthafrica.org/
https://www.maxar.com/
https://oneatlas.airbus.com/
https://www.planet.com/
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• High-frequency imagery with daily global coverage. 

• Datasets from PlanetScope, RapidEye, and SkySat satellites. 

• AI-ready dataset for agriculture, forestry, and infrastructure monitoring. 

Indian satellite data providers 

1. National Remote Sensing Centre (NRSC) - ISRO 

The NRSC, a part of ISRO, is the primary organization responsible for satellite data 

acquisition, processing, and distribution in India. 

Key Features: 

• Provides high-resolution satellite imagery 

• Offers data from Indian and foreign satellites 

• Free and paid data options 

• Services available via the Bhuvan Geoportal 

Available Data Sources: 

• Cartosat Series (Cartosat-1, 2, 3) → High-resolution optical imagery (0.25m - 2.5m) 

• Resourcesat Series (Resourcesat-1, 2, 2A) → Multispectral remote sensing (5.8m - 

56m) 

• RISAT Series (Radar Imaging Satellites) → Synthetic Aperture Radar (SAR) data for 

all-weather monitoring 

• Oceansat Series (Oceansat-1, 2, 3) → Ocean color, chlorophyll, sea surface 

temperature 

• INSAT/IMAGER (Geostationary satellites) → Meteorological and atmospheric 

monitoring 

• HySIS (Hyperspectral Imaging Satellite) → Detailed land use and vegetation 

analysis 

Website: Bhuvan Geoportal (bhuvan.nrsc.gov.in) 

2. Bhuvan - Indian Geoportal 

Bhuvan is India’s equivalent to Google Earth and offers various satellite datasets, geospatial 

services, and analytical tools. 

Key Features: 

• Free access to low and medium-resolution satellite imagery 

• Thematic datasets (land use, forest cover, water bodies, etc.) 

•  Download Cartosat and Resourcesat imagery 

• 3D terrain visualization and GIS analysis 
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Types of Data Available: 

• Topographic data 

• Thematic maps (LULC, agriculture, disaster maps, etc.) 

• Disaster monitoring (cyclones, floods, landslides) 

• Climate and meteorology data 

Website: Bhuvan Geoportal (bhuvan.nrsc.gov.in) 

3. MOSDAC - Meteorological and Oceanographic Data Archive 

MOSDAC (Meteorological and Oceanographic Satellite Data Archive Centre) is an ISRO 

initiative that provides real-time meteorological and ocean data. 

Key Features: 

• Free access to INSAT and Oceansat data 

• Real-time weather forecasts 

• Data on rainfall, humidity, sea surface temperature, ocean color 

• Used for climate monitoring, cyclone tracking, and disaster response 

Available Data Sources: 

• INSAT-3D & INSAT-3DR → Meteorological and cloud cover data 

• SCATSAT-1 → Ocean wind speed and direction 

• Oceansat-2 & Oceansat-3 → Chlorophyll concentration and sea surface temperature 

• SARAL-Altika → Ocean altimetry data 

Website: MOSDAC (mosdac.gov.in) 

4. VEDAS - Visualization of Earth Observation Data and Archival System 

VEDAS is a cloud-based geospatial data analysis platform developed by ISRO. 

Key Features: 

• Provides GIS and remote sensing analysis tools 

• Used for agriculture, forestry, water resources, disaster monitoring 

• Supports multi-temporal data visualization 

• Access to ISRO’s satellite datasets 

Available Data Sources: 

• Cartosat, Resourcesat, RISAT, Oceansat datasets 

• Climate change and vegetation monitoring tools 

• AI-based crop classification and water body mapping 

https://www.mosdac.gov.in/
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Website: VEDAS (vedas.sac.gov.in) 

5. IMGEOS - Indian Multi-Mission Ground Segment for Earth Observation Satellites 

IMGEOS is an NRSC-operated system that provides near real-time satellite data for 

applications like disaster management, urban planning, and environment monitoring. 

Key Features: 

• Provides high-resolution data from multiple ISRO satellites 

• Supports real-time disaster monitoring 

• Focuses on environment, agriculture, water resources 

Available Data Sources: 

• Cartosat-3 (0.25m resolution optical imagery) 

• Resourcesat-2 & 2A (Multispectral data for vegetation & water mapping) 

• RISAT-1 & 2 (Radar data for all-weather applications) 

Website: IMGEOS (nrsc.gov.in) 

Indian commercial satellite data providers 

1. Pixxel (Hyperspectral Imaging) 

• Specializes in hyperspectral satellite imagery for agriculture, environment, and 

climate monitoring. 

• Launching high-resolution hyperspectral satellites in 2025. 

• Website:  Pixxel (pixxel.space) 

2.  SkyMap Global 

• Provides high-resolution satellite imagery from international sources. 

• Specializes in infrastructure, real estate, and urban mapping. 

• Website:  SkyMap Global 

3.  GalaxEye (Multi-Sensor Imaging) 

• Developing fusion of optical and radar imagery for cloud-penetrating Earth 

observation. 

• Ideal for defense, disaster management, and agriculture. 

• Website: GalaxEye (galaxeye.space) 

 

 

https://www.nrsc.gov.in/
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Comparison of Indian Satellite Data Providers 

Provider Data Type Best for Access 

NRSC - 

ISRO 

Optical, SAR, 

Elevation 

Land use, Urban Planning, 

Disaster 
Free & paid 

Bhuvan 
Optical, DEM, 

Thematic 

GIS Analysis, LULC, 3D 

Visualization 
Free 

MOSDAC 
Meteorological, 

Ocean 

Weather, Cyclones, 

Oceanography 
Free 

VEDAS GIS & EO Data Agriculture, Forestry, Hydrology Free 

IMGEOS 
Near-Real-Time 

EO 

Disaster, Infrastructure 

Monitoring 
Paid 

Pixxel Hyperspectral Precision Agriculture, Climate Commercial 

SkyMap 

Global 
Optical, DEM Commercial Applications Paid 

GalaxEye 
Optical + SAR 

Fusion 

Defense, Cloud-Penetrating 

Imaging 
Upcoming 
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Introduction  

A Shapefile (.shp) is a widely used geospatial vector format in GIS. It consists of 

multiple files (.shp, .shx, .dbf) and stores points, lines, or polygons. 

Steps to Create a Shapefile in ArcGIS Pro 

1. Open ArcGIS Pro and Create a New Project 

1. Launch ArcGIS Pro 

2. Click New Project → Map 

3. Name the project and set the save location 

2. Creating a New Shapefile (Feature Class) 

Shapefiles are stored in a Geodatabase (GDB) in ArcGIS Pro. To create a standalone 

shapefile, export the feature class to a shapefile. 

Method 1: Using Catalog Pane (Recommended) 

1. Open Catalog Pane (View → Catalog Pane) 

2. Navigate to the folder where you want to store the shapefile 

3. Right-click the folder → New → Shapefile 

4. Choose the feature type: 

o Point (e.g., cities, trees) 

o Polyline (e.g., rivers, roads) 

o Polygon (e.g., land parcels, lakes) 

5. Click OK 

Method 2: Creating a Feature Class (Geodatabase) 

1. Go to Catalog Pane 

2. Expand Databases → Right-click the Default.gdb 

3. Select New → Feature Class 

4. Enter Feature Class Name 

5. Choose Geometry Type (Point, Line, Polygon) 
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6. Set Spatial Reference (e.g., WGS 84) 

7. Click Finish 

To export this as a standalone shapefile: 

1. Right-click the feature class → Export → Features 

2. Set Output Format to Shapefile (.shp) 

3. Editing and Adding Features to the Shapefile 

Step 1: Start Editing 

1. Go to Edit Tab → Create Features 

2. Select the newly created shapefile 

3. Click Point, Line, or Polygon Tool 

Step 2: Add Features 

1. Click on the map to draw points, lines, or polygons 

2. Press Enter to finish drawing 

Step 3: Save Edits 

• Click Save Edits 

• Click Stop Editing when done 

4. Attribute Table Editing (Adding Data to Features) 

1. Right-click the shapefile → Open Attribute Table 

2. Click Add Field 

3. Enter Field Name, Data Type (Text, Integer, Float) 

4. Click Save 

To update data: 

• Click Edit → Modify Attributes 

• Enter values and save 

5. Exporting and Sharing Shapefiles 

• Right-click the shapefile → Export Features 

• Save as .shp in a folder 

• Share via Email, ArcGIS Online, or Cloud Storage 

************************** 
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How to Create a Map in ArcGIS Pro: Step-by-Step Guide 

Parvaiz Ahmad Ganie* and Ravindra Posti 

ICAR-Directorate of Coldwater Fisheries Research, Bhimtal-263136, Uttarakhand. 

Corresponding author email: parvaiz.ganie@icar.gov.in 

Introduction  

Creating a map in ArcGIS Pro involves adding data, symbolizing layers, performing spatial 

analysis, and exporting the final layout. Follow these detailed steps to create a professional 

map. 

1. Open ArcGIS Pro and Start a New Project 

1. Launch ArcGIS Pro 

2. Click New Project → Map 

3. Enter a Project Name and set a save location 

4. Click OK 

2. Adding Data to the Map 

Method 1: Adding Local Data (Shapefiles, CSV, Raster) 

1. Go to Map Tab → Add Data 

2. Navigate to the folder containing your data 

3. Select the Shapefile (.shp), CSV, or Raster (.tif) 

4. Click OK to load the data 

Method 2: Adding Online Data (ArcGIS Online & Basemaps) 

1. Go to Portal Pane → Search for layers 

2. Select datasets from ArcGIS Online 

3. Click Add to Map 

3. Setting Coordinate System (Projection) 

1. Go to View Tab → Contents Pane 

2. Right-click Map → Properties → Coordinate System 

3. Choose the appropriate projection (e.g., WGS 84, UTM) 

4. Click OK 

4. Symbolizing Layers (Changing Colors & Styles) 

1. Right-click the Layer → Symbology 
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2. Choose from options: 

o Single Symbol (one color for all features) 

o Graduated Colors (color changes based on attribute values) 

o Unique Values (different colors for categories) 

3. Adjust color, size, and transparency 

4. Click Apply 

5. Labeling Features 

1. Right-click the Layer → Label Features 

2. Open Labeling Tab 

3. Choose Field (e.g., Name, Population) 

4. Adjust Font, Size, Placement 

6. Adding Essential Map Elements 

Step 1: Open Layout View 

1. Click Insert Tab → New Layout 

2. Choose a Paper Size (A4, A3, Letter, Custom) 

Step 2: Insert Map Elements 

• Map Frame: Click Insert → Map Frame 

• Legend: Click Insert → Legend → Place on Layout 

• North Arrow: Click Insert → North Arrow 

• Scale Bar: Click Insert → Scale Bar 

• Title: Click Insert → Text → Enter Title 

7. Exporting the Map 

1. Click Share Tab → Export Layout 

2. Choose File Format: 

o PDF (for printing) 

o PNG/JPEG (for images) 

o TIFF (high-resolution maps) 

3. Click Export 

8. Saving and Sharing the Map 
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• Save the ArcGIS Pro Project (.aprx) 

• Share via ArcGIS Online or Email 

 

************************** 
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